The Financial Edge™

Subsidiary Ledger Reconciliation Guide
Contents

SUBSIDIARY LEDGER RECONCILIATION ................................................................. 1
  Considerations Before Reconciling ............................................................... 2
  Steps to Prevent Errors ................................................................................. 3
  Reconciliation Process ................................................................................. 4

RECONCILING ACCOUNTS PAYABLE TO GENERAL LEDGER ......................... 7
  Account Distribution Report ........................................................................ 8
  Open Invoice Report .................................................................................... 9
  General Ledger Report .................................................................................. 9
  Troubleshooting Accounts Payable Reconciliation ......................................... 10

RECONCILING STUDENT BILLING TO GENERAL LEDGER ............................ 11
  Account Distribution Report ........................................................................ 12
  Aged Accounts Receivable Report ............................................................... 13
  Open Item Report .......................................................................................... 13
  Additional Reconciliation Reports ............................................................... 14
  Troubleshooting Student Billing Reconciliation ........................................... 15

RECONCILING ACCOUNTS RECEIVABLE TO GENERAL LEDGER .............. 17
  Account Distribution Report ........................................................................ 18
  Aged Accounts Receivable Report ............................................................... 19
  Open Item Report .......................................................................................... 19
  General Ledger Report .................................................................................. 20
  Troubleshooting Accounts Receivable Reconciliation .................................... 20

RECONCILING PAYROLL TO GENERAL LEDGER ............................................ 23
  Account Distribution Report ........................................................................ 24
  Payroll Journal .............................................................................................. 25
  General Ledger Report .................................................................................. 27
  Troubleshooting Payroll Reconciliation ....................................................... 27

RECONCILING FIXED ASSETS TO GENERAL LEDGER ............................... 29
Subsidiary Ledger Reconciliation

Considerations Before Reconciling ................................................................. 2
Steps to Prevent Errors ................................................................................. 3
Reconciliation Process .................................................................................. 4
To reconcile The Raiser’s Edge 7.6 (or higher), The Patron Edge, and subsidiary ledgers in The Financial Edge to General Ledger, you can run several reports and follow a few procedures specific to each subsidiary ledger to locate any discrepancies.


These reconciliation procedures assume a standard configuration of The Financial Edge. If your software is configured with different settings, you may need to adjust these procedures for your organization.

Considerations Before Reconciling

Warning: We strongly recommend reconciling monthly at a minimum to ensure the program remains in balance.

Before reconciling any subsidiary ledgers to General Ledger, you should carefully consider several factors and their implications.

Reconciling frequency. We strongly recommend reconciling monthly at a minimum to ensure the program remains in balance. If you wait a few months or until the end of the fiscal year to reconcile, you may encounter difficulties locating incorrect activity over this longer period. Additionally, if you have had difficulty reconciling in the past, you may want to reconcile the program after each post to General Ledger.

Posting frequency. We recommend posting weekly at a minimum. In periods of high volume, such as end of the month, you might find it beneficial to post more often.

Posting information. Set up posting information in each subsidiary ledger’s Configuration so that you can easily identify the transaction. Here are some recommendations to help you with this process:

- Ensure posting information includes more than just the name of the record. You should also include transaction numbers.
- Be sure to change the posting information for both the debit and credit description for each item type.
- Use the Reverse and Adjust references to help track deletions and adjustments. Use REV or ADJ to shorten the reason for transaction, but allow a longer description.
- Add custom fields such as “APP” and “INT” and use them to identify your applications and Interfund entries.
- Ensure the Journal selected is unique to the subsidiary ledger.
- Do not select arbitrary post dates such as the “15th of the month.” Doing so places all activity on a single day and makes reconciliation more difficult.

Summary accounts. When reconciling subsidiary ledgers to the general ledger, remember that your unfiltered subsidiary ledger reports show all transactions without regard to fund. If you have summary accounts in multiple funds, include all summary accounts in the General Ledger Report filters to find your total subsidiary ledger balance.

Unapplied cash and discount accounts should be established as separate accounts rather than part of your summary account. Including them as part of your summary account may make reconciling more difficult.

Policies and procedures guide. We recommend you create an internal Policies and Procedures Guide to ensure your staff understands these considerations and the reconciliation process in general.
Steps to Prevent Errors

You can use the following functionality within the program to help ensure your staff uses recommended data entry and posting processes:

**Business Rules.** With business rules you can customize standard procedures and requirements to suit your organization. We recommend you use the following business rules to help make reconciliation easier:

- **Use the Transaction business rule** *Do not allow post dates to be different than transaction dates in other Blackbaud Systems* to keep the post and transaction date the same. This will eliminate timing differences. If you have invoices that you want to accrue, use an attribute to mark the item, then run a report to locate the marked invoices.

  For example, if you have a large invoice that bills on the 5th of the month, but you have used $10,000 in services before month-end, you could enter the invoice as of the 5th and make a journal entry to an accrual account at the end of the month. The journal entry you create should be an automatically reversing journal entry. For more information about automatically reversing journal entries, see Knowledge Base solution BB22411.

- **Use the Journal Entry business rule** *Allow these journal codes to be used during manual journal entry* to specify General Ledger sources such as Journal Entry, Adjusting Entry, and Audit Adjustment. Disallow journal entry codes that indicate subsidiary ledger sources as Accounts Payable, Accounts Receivable, and Student Billing. This rule prevents misusing Journal Codes on manual journal entries.

- **Use the Transaction business rule** *Do not allow journal codes to be edited when posting from other Blackbaud Systems* to prohibit journal codes from being edited when posting from other Blackbaud Systems. This ensures that the journal code you designate for a subsidiary ledger is used consistently, helping you identify the source of the transactions. All post parameter files will automatically use the journal code assigned in *Configuration* of the subsidiary ledger being posted. You must create and assign journal codes before entries can be posted to General Ledger.

- **Use the Transaction business rule** *Do not allow a Summary Account to be edited or used as the primary account in other Blackbaud System transactions* to prohibit a Summary Account from being edited or used as the primary account in other Blackbaud System transactions. This rule prevents accidentally recording transactions in the wrong account.

  **Note:** Summary Accounts are defined in the Default Accounts section of *Configuration* in each subsidiary ledger.

- **Select “Never” for the Journal Entry business rule** *Allow adjusting journal entries to Blackbaud System default Summary Accounts*. This will force users to select a different account if they select a default Account Summary account for adjusting journal entries.

- **Use the General business rule** *Do not Allow a General Ledger Account Number to be used for more than one Default Account* to keep your users from mixing transactions in General Ledger accounts. For example, marking this option would not allow you to use the same account for unpaid payables and encumbrances. You can set this business rule for all subsidiary ledgers that allow you to define default accounts in *Configuration*.

- **Enable the business rule** *Exclude “Do Not Post” as a post status* in your subsidiary ledgers. With this business rule marked, the post status defaults to *Not Yet Posted* and the *Do Not Post* option is not available. This rule prevents permanent reconciliation differences, since *Do Not Post* transactions are never posted to General Ledger.

**Query.** We recommend you query posted transactions that have a different post date and transaction date. You may need to void and re-enter transactions to correct them.

**Default Distribution.** We recommend you set up default distributions on records to prevent data entry errors.

**Security.** Set up system security to prevent users from:

- Changing business rules
- Changing posting information
• Changing default accounts
• Deleting and voiding transactions

Reconciliation Process

Below are processes that should assist you with reconciling:

1. **Determine the correct report parameters to use.** Each subsidiary ledger includes balance reports, such as the Open Invoice Report and Aged Accounts Receivable Report, as well as activity reports such as the Account Distribution Report. Be sure the report’s parameters are consistent with the parameters selected on the General Ledger Report. Name your reports so you can tell which reports are to compare to the General Ledger and which are for locating differences or analyzing data.

2. **Find a starting point.** Compare the balances for each month-end from the subsidiary ledger’s balance report to the General Ledger balance.

   Run reconciliation reports for the last month of the fiscal year. If the reports match, the accounting system is in balance as of the last period of the year.

   If that period is not in balance, run the reports for the previous period. Repeat the process until you locate a period and year in balance.

   If there is no period that is in balance, look for multiple months that are off by the same amount. You may need to run the reports for specific weeks or days to identify a trend. If the reports are consistently off by the same amount, you may want to adjust by that amount.

   If a starting point cannot be established reconciling, you may need to force a reconciled balance by using a journal entry.

3. **Move forward from the starting point.** Locate the first day the subsidiary ledger goes out of balance.

   Compare the balances between the appropriate balance report and the General Ledger Report for various points throughout the month.

   For example, compare the General Ledger to the subsidiary ledger every seven days. If it goes out of balance on the 14th, then run your reconciliation reports for each day between the 7th (the last day in balance) and the 14th. Do this until you locate the exact day the ledger goes out of balance.

   If you are starting with an out of balance situation, locate the day the out of balance amount changes.

4. **Analyze the initial differences.**

   a. Run the General Ledger Report for the day the subsidiary ledger went out of balance. Check for any journal entries that may have caused the out of balance situation. Run the General Ledger Report in detail if the summary account is a control account. For more information, see Knowledge Base solution BB55402.

   b. Run the subsidiary ledger balance report for the day and the day before the ledger goes out of balance.

   c. Compare the reports, analyzing each transaction. Every item on the beginning report should either appear on the ending balance report or be removed via a transaction on the General Ledger Report. You may want to run an Account Distribution Report to provide additional information regarding the individual transaction listed on the General Ledger Report.

   d. Investigate any transaction that disappears from the beginning balance report or appears on the ending balance report without appearing on the General Ledger Report. Some items may reverse themselves on the appropriate dates. Make note of other items and the possible correction.

5. **Identify other differences.** Repeat the above steps to find any other days the subsidiary ledger went out of balance with the General Ledger. Locate all the adjustments for the month.

**Note:** Be mindful of incorrect or inconsistent data entry. Inconsistent use of journal codes and summary accounts as a primary account may make reconciling more difficult.
6. **Make adjustments and correct activity.** The corrections you may need to make will depend upon the reconciling item. You may need to reverse/correct journal entries, void, purge, and reissue checks with correct dates, or adjust or delete and re-add invoices. For items that reverse themselves, you may choose to create an automatically reversing journal entry if your auditors agree. For more information about automatically reversing journal entries, see Knowledge Base solution BB22411.

7. **Reconcile each period up to the current period.** When a balanced period is found, move forward correcting activity until the program is in balance for the current period.
Reconciling Accounts Payable to General Ledger

Open Invoice Report ................................................................. 9
Account Distribution Report ............................................... 8
General Ledger Report ......................................................... 10
Troubleshooting Accounts Payable Reconciliation ....................... 10
To ensure the program is in balance, reconcile the open invoice balance in *Accounts Payable* to the accounts payable liability account in *General Ledger* on a monthly basis.

As part of this reconciliation process, we recommend running the Account Distribution Report and Open Invoice Report in *Accounts Payable*, and the General Ledger Report in *General Ledger*. To access these reports, select **Reconciliation Reports** from the Accounts Payable Reports page.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Account Distribution Report

The Account Distribution Report for reconciliation is similar to the invoice report with the same name; however, this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger activity.

The Account Distribution Report provides distribution details for transactions contained in or produced by *Accounts Payable*. The detail report lists all transactions and associated debits and credits by account number. The summary report shows the total debits and credits associated with each account. Adjustment transactions are included to further facilitate the reconciliation process.

**Note:** For more information about running this report, see the Reconciliation Reports chapter of the *Accounts Payable Reports Guide*.

The major use of this report is to reconcile *Accounts Payable* with the general ledger. The effects of *Accounts Payable* transactions on the general ledger are illustrated by the report, which promotes reconciliation of the system.

**Report format.** In the *Report format* field, select “Detail” or “Summary” as the report format. The detail report lists all transactions and associated debits and credits by account number in detail. The summary report shows the total debits and credits associated with each account in summary. The detail account format can be more useful than the summary account format for locating differences.

**Include transactions with these dates.** Specify a start date and an end date for the posted transactions you want to include in the report. If the *Start date* field is blank, all activity is included up to the end date. If the *End date* field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.
Create an output query of. If you mark this option, the system creates a query of the records you select to include in the report. This query is available for use in other areas of the program.

Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you create the report in detail format, the report prints in Landscape.

Open Invoice Report

**Note:** For more information about running this report, see the Reconciliation Reports chapter of the *Accounts Payable Reports Guide*.

The Open Invoice Report for reconciliation is similar to the invoice report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger balance.

The Open Invoice Report lists all unpaid invoices and unapplied credit memos for a specified date range.

**Warning:** Invoices paid with a credit memo will not appear on some reports if you mark the business rule changing the invoice status to “Paid” when an applied credit memo reduces the invoice balance to zero. To include these invoices on reports, unmark the business rule in *Configuration*.

This report should balance to *General Ledger*. However, if you have problems reconciling, check for manual journal entries that affect the accounts payable liability account, and review the “Reconciliation Process” on page 4.

**Show invoices open as of.** In the *Show invoices open as of* field, enter a specific date in the *Date* field. When entering the this date, include invoices or credit memos posted through your reconciliation date, regardless of transaction date.

**Create an output query of.** If you mark this option, the system creates a query of records you select to include in the report. This query is available for use in other areas of the program.

**Report orientation.** If you are creating a Summary report, you can select Portrait or Landscape in the *Report orientation* field. When creating a Detail report, this field is disabled.
General Ledger Report

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account. You can filter by journal code to ensure only Accounts Payable transactions are included in the report. You may want to remove this filter to determine if there are transactions posted to the account that did not use the appropriate journal code.

If you use summary accounts in multiple funds, be sure to filter for all summary accounts.

**Glossary**: A journal code indicates the source of a transaction. These codes are maintained on the Tables tab of Configuration in General Ledger. You can filter many reports by journal code.

For more information about the General Ledger Report, see the Account Reports chapter of the Reports Guide for General Ledger.

Troubleshooting Accounts Payable Reconciliation

Before you begin Accounts Payable reconciliation troubleshooting, familiarize yourself with “Reconciliation Process” on page 4.

Using the Open Invoice Report and Account Distribution Report from Accounts Payable, and the General Ledger Report in detail from General Ledger, you can check for discrepancies and reconcile Accounts Payable to General Ledger. The Open Invoice Report may not equal the General Ledger balance for accounts payable for a number of reasons:

**Deleted invoices.** Deleted invoices appear on the Open Invoice Report up until the deleted date. The invoice shows as open in General Ledger from the original post date until the deleted date. When an invoice is deleted, a screen appears so you can select a reversal date. Select the same period as for the invoice date. You must post reversals to General Ledger before they reflect in the accounts payable account.

To display deleted invoices in Accounts Payable, select Tools, Options from the Invoices page of Records. On the Records tab in Options, select Vendor Activity and mark Show deleted transactions.

**Deleted credit memos.** You must unapply a credit memo before you can delete it. To display deleted credit memos in Accounts Payable, select Tools, Options from the Credit Memos page of Records. On the Records tab of Options, select Vendor Activity and mark Show deleted transactions.

**Manual journal entries.** Manual journal entries to the accounts payable account in General Ledger do not appear in Accounts Payable.

**Different periods for transaction and post dates.** Payments with payment and post dates in different periods may also change the accounts payable summary account balance. These dates should be in the same period. Invoices appear on the General Ledger Report based on post date. If a post date used is in a different fiscal period from the invoice date, you will see a discrepancy between Accounts Payable and General Ledger.

**Beginning balances.** You may inadvertently double post if beginning balances are entered into the accounts payable account in General Ledger, and then enter invoices into Accounts Payable with a status of Not Yet Posted. After posting, your General Ledger balance would be doubled.
Reconciling Student Billing to General Ledger

Account Distribution Report ................................................................. 12
Aged Accounts Receivable Report ............................................................ 13
Open Item Report ............................................................................... 13
Additional Reconciliation Reports .......................................................... 14
Account Activity Report ..................................................................... 14
Account Balance Report ..................................................................... 14
Transaction List .................................................................................. 15
Cash Receipts Report .......................................................................... 15
General Ledger Report ........................................................................ 15
Transaction Journal ........................................................................... 15
Troubleshooting Student Billing Reconciliation. ...................................... 15
To ensure student billing activity is correctly reflected in the general ledger, reconcile *Student Billing* to the accounts receivable account in *General Ledger* on a monthly basis.

As part of this reconciliation process, we recommend running the Account Distribution Report, Aged Accounts Receivable Report, and Open Item Report in *Student Billing*. To access these reports, select *Reconciliation Reports* from the Student Billing Reports page.

For information about additional reports you can use for reconciliation, see “Additional Reconciliation Reports” on page 14.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Account Distribution Report

The Account Distribution Report for reconciliation is similar to the transaction report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger activity.

The Account Distribution Report lists debit and credit amounts for accounts in *General Ledger* created by *Student Billing* transactions and adjustments.

If you void payments from students or parents and create bank adjustments, they will not appear in the Account Distribution Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report and filter for the journal code used when posting cash management adjustments. You can also run the Bank Register Report and filter on cash management adjustments.

For more information about the Account Distribution Report, see the Reconciliation Reports chapter of the *Reports Guide for Student Billing*.

---

**Report format.** In the *Report format* field, select “Detail” or “Summary”. The detail account format can be more useful than the summary account format for locating differences.

**Include transactions with these dates.** Specify a start date and an end date for the posted transactions you want to include in the report. If the *Start date* field is blank, all activity is included up to the end date. If the *End date* field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Create an output query of [ ].** If you mark this checkbox, you can select to create a query of accounts, records, charges, credits, refunds, payments or deposits. You can use the query later in other areas of *Student Billing*. 
Report orientation. If you create the report in summary format, you can select Portrait or Landscape. If you create the report in detail format, the report prints in landscape.

Aged Accounts Receivable Report

The Aged Accounts Receivable Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger balance.

The Aged Accounts Receivable Report provides a list of charge balances distributed to aging periods. This report is useful for determining past due and current balances of records who own or are assigned activity. For example, you can run the Aged Accounts Receivable Report to quickly see past due balances of your school’s student, individual, and organization accounts.

Note: For more information about the Aged Accounts Receivable Report, see the Reconciliation chapter of the Reports Guide for Student Billing.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable, payments are included or excluded based on the “age as of date”. In Student Billing, charges, payments, and credits are included based on the transaction date filters. The “aging as of date” is independent of the transactions.

Calculate aging as of. In the Calculate aging as of field, enter a specific date for the aging period.

Create an output query of []. If you mark this checkbox, the program creates a query of records or charges included in the report. You can use the query later in other areas of Student Billing.

Note: Click Preview at any time to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

Report orientation. In this field, select “Portrait” or “Landscape”.

Open Item Report

The Open Item Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger balance.

Use the Open Item Report to list unpaid charges and any credits and payments applied to those charges in a specific date range. On the report, mark the checkbox to include unapplied payments and credits. The total amount of posted activity, including unapplied activity, should equal the balance of the receivables account.
For more information about the Open Item Report, see the Reconciliation Reports chapter of the *Reports Guide for Student Billing*.

**Show transactions open as of.** In the *Show transactions open as of* field, specify a date for transactions to include. All transactions open as of this date are included.

**Create an output query of [ ].** If you mark this checkbox, the program creates a query of the records or charges included in the report. You can use the query later in other areas of *Student Billing*.

**Note:** Click **Preview** at any time to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

**Report orientation.** In this field, select “Portrait” or “Landscape”.

### Additional Reconciliation Reports

In addition to the *Student Billing* Reconciliation Reports, you can use the following reports to help you ensure your student billing subsidiary ledger transactions are in balance with your general ledger:

#### Account Activity Report

The Account Activity Report lists all student activity, including charges, credits, and payments. This report provides specific details for each transaction and receipt listed, including transaction or receipt number, date, type, fee, and amount. You can compare this report’s total amount to the accounts receivable account in the General Ledger Report.

For more information about the Account Activity Report, see the Transaction Reports chapter of the *Reports Guide for Student Billing*.

#### Account Balance Report

The Account Balance Report lists each student’s name, grade, and account balance. If all activity is posted, and no transactions are marked as Do Not Post, the total balance in this report should match the General Ledger Report.

For more information about the Account Balance Report, see the Transaction Reports chapter of the *Reports Guide for Student Billing*. 
Transaction List

Using the Transaction List, you can list all charges and credits for all students. You must use this report in conjunction with the Cash Receipts Report. To reconcile this report, use the formula of Total Charges - Total Credits - Cash Receipts Report = Accounts Receivable Account.

For more information about the Transaction List, see the Transaction Reports chapter of the Reports Guide for Student Billing.

Cash Receipts Report

The Cash Receipts Report displays a list of all payments and advance deposits received within a range of dates. With this report, you can filter by both post status and date. Balances in this report should equal those of the General Ledger cash account.

For more information about the Cash Receipts Report, see the Deposit and Receipt Reports chapter of the Reports Guide for Student Billing.

General Ledger Report

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

Once you run the report, subtract any manual entries or transactions not associated with the Student Billing journal code. This general ledger balance should equal those balances presented in the Student Billing reports.

For more information about the General Ledger Report, see the Account Reports chapter of the Reports Guide for General Ledger.

Transaction Journal

The Transaction Journal lists debits and credits posted to specific accounts for specified journal codes.

For more information about the Transaction Journal, see the Journal and Batch Reports chapter of the Reports Guide for General Ledger.

Troubleshooting Student Billing Reconciliation

Before you begin Student Billing reconciliation troubleshooting, familiarize yourself with “Reconciliation Process” on page 4.

If the numbers produced from the reports in Student Billing and General Ledger do not match, determine which balance is higher. Then consider these scenarios:

Higher Student Billing Balance. Check for transactions entered with a post status of Do Not Post; General Ledger does not reflect this activity unless the transactions were entered manually in General Ledger. Also, any activity that has transaction and post dates in different periods may not appear in General Ledger for the same time period.

Higher General Ledger Balance. Check for manual journal entries made to the account in question. Manual journal entries to an account in General Ledger do not appear in Student Billing, and these entries change the account balance. Activity with transaction and post dates in different periods may also affect this scenario.
Cash management adjustments not showing up in Account Distribution Report. If you void payments from students or parents and create bank adjustments, they will not appear in the Account Distribution Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report and filter for the journal code used when posting cash management adjustments. You can also run the Bank Register Report and filter on cash management adjustments.
Reconciling Accounts Receivable to General Ledger

Account Distribution Report ................................................................. 18
Aged Accounts Receivable Report .......................................................... 19
Open Item Report .................................................................................. 19
General Ledger Report ......................................................................... 20
Troubleshooting Accounts Receivable Reconciliation............................ 20
To ensure accounts receivable activity is correctly reflected in the general ledger, reconcile the open item balance in *Accounts Receivable* to the accounts receivable account in *General Ledger* on a monthly basis.

As part of this reconciliation process, we recommend running the Account Distribution Report, Aged Accounts Receivable Report, and Open Item Report in *Accounts Receivable*. To access these reports, select *Reconciliation Reports* from the Accounts Receivable Reports page.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Account Distribution Report

The Account Distribution Report for reconciliation is similar to the transaction report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger activity.

The Account Distribution Report lists debit and credit amounts, created by *Accounts Receivable* transactions and adjustments, for *General Ledger* accounts.

If you void payments from clients and create bank adjustments, they will not appear in the Account Distribution Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report and filter for the journal code used when posting cash management adjustments. You can also run the Bank Register Report and filter on cash management adjustments.

For more information about the Account Distribution Report, see the Transaction Reports chapter of the *Reports Guide for Accounts Receivable*.

---

**Report format.** In the *Report format* field, select “Detail” or “Summary”. The detail account format can be more useful than the summary account format for locating differences.

**Include transactions with these dates.** Specify a start date and an end date for the posted transactions you want to include in the report. If the *Start date* field is blank, all activity is included up to the end date. If the *End date* field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Create an output query of [ ].** If you mark *Create an output query of*, you can select for the program to create a query of the included accounts, clients, charges, credits, invoices, returns, refunds, or payments. You can use the query later in other areas of *Accounts Receivable*.

**Report orientation.** If you create the report in summary format, you can select Portrait or Landscape. If you create the report in detail format, the report prints in Landscape.
Aged Accounts Receivable Report

The Aged Accounts Receivable Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger balance.

Use the Aged Accounts Receivable Report to list balances distributed in aging periods defined in Configuration. This report is useful in determining past due and current balances of clients.

**Note:** We recommend you reconcile your subsidiary ledger transactions monthly.

The Aged Accounts Receivable Report is different than the Aged Accounts Payable Report. In Accounts Payable, payments are included or excluded based on the “age as of date”. In Accounts Receivable, charges, payments, and credits are included based on the transaction date filters. The “aging as of date” is independent of the transactions.

You can use this report whether you use a single-party billing system or third-party billing system. If you use a third-party billing system, keep the definitions of payer and recipient clients in mind:
- A payer is a person or organization responsible for paying a bill.
- A recipient is a person or organization that receives a product or service, or has its balance reduced by a payment or credit.

**Calculate aging as of.** In the Calculate aging as of field, enter a specific date for the aging period.

**Create an output query of [ ].** If you mark Create an output query of, select Clients or Charges. The program creates a query of clients or charges included in the report. You can use the query later in other areas of Accounts Receivable.

**Report orientation.** In this field, you can select to print the report in Portrait or Landscape format.

Open Item Report

The Open Item Report for reconciliation is similar to the analysis report with the same name, however this report has predefined defaults to help you identify the transactions that are part of your subsidiary ledger balance.

Use the Open Item Report to list unpaid charges and any credits and payments applied to those charges in a specified date range. On the report, mark the checkbox to include unapplied payments and credits. The total amount of posted activity, including unapplied activity, should equal the balance of the receivables account. If you are using an unapplied payment account, the total amount of posted activity should equal the balance of the receivables account and suspense account.
For more information about the Open Item Report, see the Reconciliation Reports chapter of the *Reports Guide for Accounts Receivable*.

### Show transactions open as of

In the **Show transactions open as of** field, specify a date for charges to include. All charges open as of this date are included.

### Create an output query of [ ].

If you mark **Create an output query of**, select Clients or Charges. The program creates a query of the clients or charges included in the report. You can use the query later in other areas of *Accounts Receivable*.

### Report orientation

In the **Report orientation** field, select “Portrait” or “Landscape”.

---

**General Ledger Report**

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the *Reports Guide for General Ledger*.

---

**Troubleshooting Accounts Receivable Reconciliation**

Before you begin *Accounts Receivable* reconciliation troubleshooting, familiarize yourself with “Reconciliation Process” on page 4.

If the numbers produced from the reports in *General Ledger* and *Accounts Receivable* do not match, determine which is higher. Then consider these scenarios:

#### Higher Accounts Receivable balance.

Check for transactions entered with a post status of Do Not Post; *General Ledger* does not reflect this activity unless the transactions were entered manually in *General Ledger*. Also, any activity that has transaction and post dates in different periods may not appear in *General Ledger* for the same time period.

#### Higher General Ledger balance.

Check for manual journal entries made to the account in question. Manual journal entries to an accounts receivable account in *General Ledger* do not appear in *Accounts Receivable*, and these entries change the account balance. Activity with transaction and post dates in different periods may also affect this scenario.

#### Processing payments when not using a single AR summary account.

Keep in mind processing payments with application dates and post dates in different periods can affect reconciliation.
Assigning transactions a Do Not Post status when not using a single AR summary account. This process can have a major impact on reconciliation. For example, suppose you enter an invoice for $100 as Do Not Post, then enter a payment for $100 as Not Yet Posted, and then post. Finally, you apply the payment to the invoice. These transactions do not correctly balance all accounts.

Cash management adjustments not showing up in Account Distribution Report. If you void payments from clients and create bank adjustments, they will not appear in the Account Distribution Report. To find adjustment amounts that are part of your reconciliation, you can run a GL General Ledger Report and filter for the journal code used when posting cash management adjustments. You can also run the Bank Register Report and filter on cash management adjustments.
Reconciling Payroll to General Ledger

Account Distribution Report ................................................................. 24
Payroll Journal ...................................................................................... 25
General Ledger Report .......................................................................... 27
Troubleshooting Payroll Reconciliation .................................................. 27
To ensure payroll activity is reflected correctly in the general ledger, reconcile Payroll to the cash account in General Ledger on a monthly basis. You can reconcile each component of the payroll calculation separately.

As part of the reconciliation process, we recommend running the Account Distribution Report and Payroll Journal from Payroll, and the General Ledger Report in detail from General Ledger.

You can run tax reports to match up tax amounts to the Payroll Journal. For more information about tax reports, see the Mail Guide for The Financial Edge.

Before running these reports, you should familiarize yourself with the following information:
- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Account Distribution Report

The Account Distribution Report lists debit and credit amounts, created by Payroll calculations and adjustments, for General Ledger accounts. The amounts should match the balance of the General Ledger accounts.

For more information about the Account Distribution Report, see the Transaction Reports chapter of the Reports Guide for Payroll.

**Report format.** In the Report format field, select Detail or Summary.

**Payment date.** In the Payment date field, select a date or date range for the payments to include in the report. The dates referenced are the payment dates on checks and EFTs.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all payments are included up to the end date. If the End date field is blank, all payments from the start date forward, including transactions with a date in the future, are included. If both fields are blank, all payments are included.

**Payment post date.** In the Payment post date field, select a date or date range of payment post dates to include in the report.
If you select <Specific range>, you can specify a start and end date. If the **Start date** field is blank, all payments are included up to the end date. If the **End date** field is blank, all payments from the start date forward, including transactions with a post date in the future, are included. If both fields are blank, all payments are included.

**Note:** For reporting purposes, we recommend using a single check per calculation. If you pay multiple calculations with a single check, the entire check is omitted from the report, even if one calculation meets the period end date filter.

**Period ending date.** In the **Period ending date** field, select a date or date range of payments to include in the report based on period ending dates of associated calculations. If multiple calculations are paid by a single check, the entire check is omitted from the report, even if one calculation meets the period end date filter.

If you select <Specific range>, you can specify a start and end date. If the **Start date** field is blank, all payments are included up to the end date. If the **End date** field is blank, all activity from the start date forward, including payments with a post date in the future, are included. If both fields are blank, all activity is included.

**Include adjustment transactions.** You can include adjustment transaction, which will show how adjustments impact existing distributions.

**Create an output query of [ ].** If you mark **Create an output query of**, you can select for the program to create a query of the included accounts, employees, or payments. You can use the query later in other areas of **Payroll**.

**Note:** Click **Preview** to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

**Report orientation.** Select Portrait for the report to appear vertically or Landscape for the report to appear horizontally. When running the report in detail, report orientation is automatically set to Landscape and cannot be changed.

**Payroll Journal**

Using the Payroll Journal, you can review the components of each payment, including pay types, benefits, and deductions, that calculate the net pay. You can also include the account distributions.
For more information about the Payroll Journal, see the Transaction Reports chapter of the *Reports Guide for Payroll*.

**Include.** In this field, designate the types of calculations to include in the report. You can select paid, unpaid, or include both types.

**Payment date.** In the Payment date field, select a date or date range for the payments to include in the report. The dates referenced are the pay dates on calculations. If the calculations have been paid, the dates reference the payment dates on the checks and EFTs.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all payments are included up to the end date. If the End date field is blank, all payments from the start date forward, including transactions with a date in the future, are included. If both fields are blank, all payments are included.

**Note:** For reporting purposes, we recommend using a single check per calculation. If you pay multiple calculations with a single check, the entire check is omitted from the report, even if one calculation meets the period end date filter.

**Period ending date.** In the Period ending date field, select a date or date range of payments to include in the report based on period ending dates of associated calculations. If multiple calculations are paid by a single check, the entire check is omitted from the report, even if one calculation meets the period end date filter.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all payments are included up to the end date. If the End date field is blank, all activity from the start date forward, including payments with a post date in the future, are included. If both fields are blank, all activity is included.

**Note:** Click Preview to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

**Payment post date.** In the Payment post date field, select a date or date range of payment post dates to include in the report. This field is available only if you are including paid calculations in the report.
If you select <Specific range>, you can specify a start and end date. If the **Start date** field is blank, all payments are included up to the end date. If the **End date** field is blank, all payments from the start date forward, including transactions with a post date in the future, are included. If both fields are blank, all payments are included.

**Include employer liabilities and expenses.** Mark this checkbox to include a section in the report for employer contribution benefits and employer taxes.

**General Ledger Report**

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the *Reports Guide for General Ledger*.

**Troubleshooting Payroll Reconciliation**

If the numbers produced from the reports in **General Ledger** and **Payroll** do not match, determine which is higher. Consider these scenarios:

**Higher Payroll balance.** Look for checks with a post status of Do Not Post; **General Ledger** does not reflect this activity. Also, any activity with transaction and post dates in different periods may not appear in **General Ledger** for the same time period.

**Higher General Ledger balance.** Check for manual journal entries made to the account in question. **Payroll** does not reflect manual journal entries, and these entries change the account balance. Also, activity with transaction and post dates in different periods may affect this scenario.
Reconciling Fixed Assets to General Ledger

Account Distribution Report ................................................................. 30
Year-to-Date Depreciation Report .......................................................... 31
General Ledger Report ................................................................. 32
Troubleshooting Fixed Assets Reconciliation .............................................. 32
To ensure fixed asset activity is correctly reflected in the general ledger, reconcile depreciation in *Fixed Assets* to depreciation expense accounts in *General Ledger* on a monthly basis. Following this process ensures depreciation expenses are being recorded properly.

As part of the reconciliation process, we recommend running the Account Distribution Report and Year-to-Date Depreciation Report from *Fixed Assets*, and the General Ledger Report in detail from *General Ledger*.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

**Account Distribution Report**

The Account Distribution Report is a list of debits and credits for specified accounts posted from *Fixed Assets*. The debits and credits in this report should match the account detail in *General Ledger*.

For more information about the Account Distribution Report, see the Transaction Reports chapter of the *Reports Guide for Fixed Assets*.

**Report Format.** In the *Report Format* field, select the amount of detail you want in the report. Select Detail or Summary.

**Asset in service date.** In the *Asset in service date* field, select the dates in which the assets were placed in service. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If you leave the *Start date* field blank, all activity is included up to the end date. If you leave the *End date* field blank, all activity from the start date until present is included. If you leave both fields blank, all activity is included.

**Asset disposal date.** In the *Asset disposal date* field, select the dates in which the assets were disposed or will be disposed. You can select to include all dates, a specific date, or a specific date range.
If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date until present is included. If you leave both fields blank, all activity is included.

Transaction date. In the Transaction date field, select dates of transactions to include in the report. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Post date. In the Post Date field, select the post dates for transactions to include in the report. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Include adjustment transactions. Mark this checkbox to include adjustment transactions in the report.

Create an output query of assets. If you mark this option, the program creates a query of the assets you select and includes it in the report. This query is available for use in other areas of the program.

Report orientation. If you select Summary in the Report format field, you can select Portrait or Landscape in the Report orientation field. If you select Detail, you can print the report in landscape format only.

Year-to-Date Depreciation Report

The Year-to-Date Depreciation Report lists both prior-year and year-to-date depreciation and depreciable basis. The report total should match the detail General Ledger Report for all depreciation expense accounts. The Year-to-Date Depreciation Report includes no specific account number filter; instead it assumes all departments selected are posting to the same depreciation expense account.

For more information about the Year-to-Date Depreciation Report, see the Transaction Reports chapter of the Reports Guide for Fixed Assets.
Calculate year-to-date depreciation as of. In the Calculate year-to-date depreciation as of field, select Today or <Specific date>.

Asset in service date. In the Asset in service date field, select the dates in which the assets were placed in service. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date until present is included. If you leave both fields blank, all activity is included.

Asset disposal date. In the Asset disposal date field, select the dates in which the assets were disposed or will be disposed. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If you leave the Start date field blank, all activity is included up to the end date. If you leave the End date field blank, all activity from the start date until present is included. If you leave both fields blank, all activity is included.

Transaction date. In the Transaction date field, select dates of transactions to include in the report. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Post date. In the Post Date field, select the post dates for transactions to include in the report. You can select to include all dates, a specific date, or a specific date range.

If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Create an output query of assets. If you mark this option, the program creates a query of the assets you select and includes it in the report. This query is available for use in other areas of the program.

Report orientation. In the Report orientation field, select Portrait or Landscape.

General Ledger Report

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the Reports Guide for General Ledger.

Troubleshooting Fixed Assets Reconciliation

If the numbers produced from the reports in General Ledger and Fixed Assets do not match, determine which is higher. Consider these scenarios:

Higher Fixed Assets balance. Check for depreciation entered with a post status of Do Not Post; General Ledger does not reflect this activity. Also, any activity with transaction and post dates in different periods may not appear in General Ledger for the same time period.

Higher General Ledger balance. Check for manual journal entries made to the account in question. Fixed Assets does not reflect manual journal entries, and these entries change the account balance. Also, activity with transaction and post dates in different periods may affect this scenario.
Reconciling Purchase Orders to General Ledger

Encumbrance Report .......................................................... 34
General Ledger Report ........................................................ 35
Troubleshooting Purchase Orders Reconciliation ....................... 35
To ensure purchase order activity is correctly reflected in the general ledger, reconcile the open encumbrance balance in *Purchase Orders* to the encumbrance liability account in *General Ledger* on a monthly basis.

As part of the reconciliation process, we recommend running the Encumbrance Report from *Accounts Payable* and the General Ledger Report in detail. With these reports you can check for discrepancies and reconcile *Purchase Orders* to *General Ledger*.

As another check, you can run a trial balance for only encumbrance amounts. The Encumbrance Report and the account totals on the trial balance should match. The balance of the encumbrance summary account in *General Ledger* should equal the grand total of the Encumbrance Report in *Accounts Payable*.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Encumbrance Report

The Encumbrance Report lists the encumbrance post balance and accounts and projects to which each line item was posted. Before running the Encumbrance Report, you should first post all purchase orders.

For more information about the Encumbrance Report, see the Purchase Orders Reports chapter of the *Reports Guide for Accounts Payable*.

---

**Include purchase orders with these dates.** In the *Purchase order date* field of the *Include purchase orders with these dates* frame, select a date range or specific date.

If you select <Specific range>, you can specify a start and end date. If the *Start date* field is blank, all activity is included up to the end date. If the *End date* field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Include line items with these posting dates.** In the *Post date* field of the *Include line items with these posting dates* frame, select a date range or specific date.
If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

Include PO’s whose encumbrance post balance is zero. To include purchase orders that have been fully receipted, mark this checkbox.

Create an output query of. If you mark this option, the system creates a query of the record you select and includes it in the report. This query is available for use in other areas of the program.

Note: Click Preview to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

Report orientation. Landscape is the only report orientation available for this report.

General Ledger Report

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the Reports Guide for General Ledger.

Troubleshooting Purchase Orders Reconciliation

If numbers produced from reports in General Ledger and Purchase Orders do not match, determine which is higher. Consider these scenarios:

Higher Purchase Orders balance. Check for transactions entered with a post status of Do Not Post; General Ledger does not reflect this activity unless transactions were entered manually in General Ledger. Also, any activity with transaction and post dates in different periods may not appear in General Ledger for the same time period.

Higher General Ledger balance. Check for manual journal entries made to the account in question. Purchase Orders does not reflect manual journal entries, and these entries change the account balance. Also, activity with transaction and post dates in different periods may affect this scenario.

Numbers overall do not match. Review the encumbrance report for any purchase orders that may reflect an inaccurate encumbrance balance. If the program includes any closed purchase orders with a remaining encumbrance balance, contact Blackbaud Customer Support at 800-468-8996 for assistance.
Reconciling The Raiser’s Edge to General Ledger

Account Distribution Report ................................................................. 38
General Ledger Audit Report ............................................................. 41
General Ledger Report ................................................................. 44
Transaction Journal Report ............................................................ 48
Troubleshooting Raiser’s Edge Reconciliation ...................................... 50
To ensure activity in *The Raiser’s Edge* is correctly reflected in the general ledger, reconcile gifts posted from *The Raiser’s Edge* to *General Ledger* on a monthly basis.

As part of the reconciliation process, we recommend running the Account Distribution Report and General Ledger Audit Report from *The Raiser’s Edge*, and the General Ledger Report in detail from *General Ledger*.

Before running these reports, you should familiarize yourself with the following information:
- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

### Account Distribution Report

The Account Distribution Report is a list by account number of gifts within a specific date range. You can run this report by post status or gift type.

For more information about the Account Distribution Report, see the *Reports Guide* in the *Raiser’s Edge* documentation.

- **Running the Account Distribution Report**
  1. On the navigation bar in *The Raiser’s Edge*, click Reports. The Reports page appears.
  3. In the list on the left, select Account Distribution Report.

5. In the **Date to use** field of the **Include Gifts with these Dates** frame, select “GL post date”.
6. In the **Date** field, select “<Specific range>”.
7. In the **Start** and **End** fields, enter beginning and ending dates for the reconciliation period.
8. Select the Gift Types tab.

9. In the Gift Types frame, select gift types to include in the reconciliation. Click the single arrow to move each gift type into the Include these Gift Types box.

10. Select the Format tab.

11. Select Detail in the list on the left.

12. In the Include Gifts frame, mark Posted.

13. Click Print. A message appears telling you the program is processing the report.
14. Click the **Save** button on the toolbar to save the new report. The Save Report as screen appears.

15. In the **Report name** field, enter a name for the report.
16. In the **Description** field, enter a description.
17. To give other users rights to run or modify this account distribution report, mark **Others can run this report** and **Others can modify this report**.
18. Click **Save** to save the new report.

**General Ledger Audit Report**

When you delete or reverse gifts, the program creates a reversing entry in **General Ledger**; however, deleted gifts do not appear in reports from **The Raiser’s Edge**. The General Ledger Audit Report lists any posted activity deleted from **The Raiser’s Edge**, including activity omitted from the Account Distribution Report. For more information about the General Ledger Audit Report, see the **Reports Guide** in the **Raiser’s Edge** documentation.

Once you run the General Ledger Audit Report, you can remove activity from **The Raiser’s Edge** by either deleting or adjusting activity. If you delete activity, the program creates reversing entries to post to **General Ledger**. If you adjust activity, the program creates adjusting entries to **General Ledger**. You must post to **General Ledger** to transfer the information.

- **Running the General Ledger Audit Report**
2. Click **Financial Reports**. The Financial Reports page appears. A list of all financial reports appears on the left of the page.

3. In the list on the left, select **General Ledger Audit Report**.

5. In **Date to use** field of the **Include Gifts with these Dates** frame, select “GL post date”.
6. In the **Date** field, select “<Specific range>”.

---

The Account Distribution Report provides a breakdown, by General Ledger accounts, of gifts within the specified date range.
7. In the **Start** and **End** fields, enter beginning and ending dates for the reconciliation period.

![Image of the New General Ledger Audit Report window with Start and End date fields filled in with dates.]

8. Select the **Gift Types** tab.

![Image of the New General Ledger Audit Report window with the Gift Types frame open, showing various gift types and the Include these Gift Types box highlighted.]

9. In the **Gift Types** frame, select gift types to include in the reconciliation. Click the single arrow to move each gift type into the **Include these Gift Types** box.

10. Click **Print**. A message appears telling you the program is processing the report.
11. Click the **Save** button on the toolbar to save the new report. The Save Report as screen appears.

![Save Report As](image)

12. In the **Report name** field, enter a name for the report.
13. In the **Description** field, enter a description.
14. To give other users rights to run or modify this general ledger audit report, mark **Others can run this report** and **Others can modify this report**.
15. Click **Save** to save the new report.

**General Ledger Report**

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the *Reports Guide for General Ledger*.

- **Running the General Ledger Report in detail**
  1. From the Reports page in **General Ledger**, click **Account Reports**. The Account Reports page appears. A list of all account reports appears on the left of the page.

![Account Reports](image)

2. In the list on the left, select **General Ledger Report**.

4. In the **Template** field of the **Include accounts from this chart template** frame, select to include all or selected accounts in the report. You can create chart templates in **Visual Chart Organizer**. For more information, see the **Visual Chart Organizer Guide**.

5. In the **Date** field of the **Include account activity as of this date** frame, select “<Specific range>”.

6. In the **Start date** and **End date** fields, enter the same starting and ending dates used for the reports in *The Raiser’s Edge*.

**Note:** You can change the results of a report by using different chart templates to run the same report. You can define an unlimited number of templates in **Visual Chart Organizer**. For more information, see the **Visual Chart Organizer Guide**.
7. In the **Report orientation** field, select “Landscape”.

![New General Ledger Report dialog box](image)

8. Select the Filters tab.

9. In the **Include** column for the Accounts filter, choose “Selected”. The Accounts screen appears.

![Accounts screen](image)

**Note:** You can use the small binoculars to search for an account segment or use the large binoculars to search for an account number.

10. In the **Account** column, enter the account numbers for *The Raiser's Edge* or click the binoculars to search for the accounts.

11. Click **OK**. You return to the Filters tab and the selected account numbers appear in the **Selected Filters** column.
12. In the **Include** column for the Journals filter, choose “Selected”. The Selected Journals screen appears.

13. Select your journal for **The Raiser’s Edge** and click the single right arrow. The journal appears in the **Include these journals** box.

14. Click **OK**. You return to the Filters tab and the **Raiser’s Edge** journal appears in the **Selected Filters** column.

**Tip:** Create a code for each of your subsidiary ledgers in the **Journal** table in **Configuration**.

15. Click **Print**. A message appears telling you the program is processing the report.
16. Click the **Save** button on the toolbar to save the new report. The Save Report as screen appears.

![Save Report as dialog box](image1.png)

17. In the **Report name** field, enter a name for the report.
18. In the **Description** field, enter a description.
19. To give other users rights to run or modify this general ledger report, mark **Others can run this report** and **Others can modify this report**.
20. Click **Save** to save the new report.

**Transaction Journal Report**

The Transaction Journal lists the debits and credits entered directly from *Journal Entry* or posted from other Blackbaud programs, such as *The Raiser’s Edge*.

For more information about the Transaction Journal Report, see the Journal and Batch Reports chapter of the *Reports Guide for General Ledger*.

- **Running the Transaction Journal Report**
  1. From the Reports page in *General Ledger*, click **Journal and Batch Reports**. The Journal and Batch Reports page appears.

![Journal and Batch Reports screen](image2.png)

2. In the list on the left, select **Transaction Journal**.

4. In the **Date** field, select a date or date range for the posted transactions you want to include. Use the same date range specified in the Account Distribution Report.

   If you select <Specific range>, you can specify a start date and an end date. If you leave the **Start date** field blank, all activity is included up to the end date. If you leave the **End date** field blank, all activity from the start date until present is included. If you leave both fields blank, all activity is included.

5. In the **Report orientation** field, select “Landscape”.

6. Select the Filters tab. On this tab, you can include information based on criteria such as transaction, batches, categories, and journals. For example, you can include certain journals, and journals not selected do not appear on the report.

7. To create the Transaction Journal to reconcile to the Account Distribution Report from The Raiser’s Edge, select the following filters:
Tip: Create a code for each of your subsidiary ledgers in the Journal table in Configuration.

- **Journals** - Selected - The Raiser’s Edger (or Journal code used when posting from Raiser’s Edge).
- **Not Yet Posted Transactions** - None (default)
- **Accounts** - Selected - Choose an account query filtering out Transfer accounts, or any other accounts used for balancing interfund entries.

8. Select the Format tab.

9. In the Sort/Break section of the Format tab, sort by “Journal” and ensure the Break? checkbox is marked.

10. In the Break Footer for Journal section, mark the Print count per Journal checkbox.

11. Click Print. A message appears telling you the program is processing the report.

12. Click the Save button on the toolbar to save the new report.

**Troubleshooting Raiser’s Edge Reconciliation**

Numbers produced from reports in The Raiser’s Edge and General Ledger may not match because of activity not yet posted or imported. You can post from The Raiser’s Edge in two ways: posting directly to General Ledger, or posting from The Raiser’s Edge and then importing the file into General Ledger.

If The Raiser’s Edge contains gifts not yet posted or if posted batches are not imported (or are mistakenly imported more than once), balances in General Ledger will be affected.
Reconciling Cash Receipts to General Ledger

Deposit List .......................................................... 52
Account Distribution Report ........................................... 53
General Ledger Report .................................................. 54
Troubleshooting Cash Receipts Reconciliation ......................... 54
To ensure cash receipt activity is correctly reflected in the general ledger, reconcile deposits in *Cash Receipts* to the cash account in *General Ledger* on a monthly basis. Although bank statements should reflect all deposits, you can also run reconciliation reports to balance cash accounts.

As part of the reconciliation process, we recommend running the Deposit List and Account Distribution Report from *Cash Receipts*, and the General Ledger Report in detail from *General Ledger*.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

**Deposit List**

**Note:** To see more detail about a deposit, you can run the Deposit Report.

The Deposit List provides summarized deposit information, including deposit number and deposit date, and provides a grand total. For more information about the Deposit List, see the Deposit and Receipt Reports chapter of the *Reports Guide for Cash Receipts*.

**Deposit date.** In the Deposit Date field, select a date or date range for transaction dates to include in the report.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Entered on date.** In the Entered on date field, select a date or date range for which deposits were entered into the program.

**Post date.** In the Post Date field, select a date or date range for post dates to include in the report.
Include deposit numbers from [ ] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a range of deposit numbers to include in the report. If you leave both fields blank, the report includes all deposit numbers.

**Note:** Click **Preview** to view the report as it will print using your selections and filters. Click **Layout** to view a sample layout of the report without data.

Only include deposits whose amounts are greater than [ ]. Mark this option to enter the minimum deposit amount to include in the report.

Include deposits from [ ]. Mark the checkbox for each program whose deposits you want to include in the report. The options appearing depend on the programs you have installed (Accounts Receivable, Cash Receipts, or Student Billing).

Create an output query of deposits. Mark this option to create a query of deposits that appear in the report. This query is available for use in other areas of the program.


**Account Distribution Report**

The Account Distribution Report is a list of debits and credits for specified accounts posted from Cash Receipts. The debits and credits in this report should match the account detail in General Ledger. For more information about the Account Distribution Report, see the Transaction Reports chapter of the Reports Guide for Cash Receipts.

**Report format.** In the Report format field, select Summary or Detail. The detail report lists all transactions and associated debits and credits by account number. The summary report shows the total debits and credits associated with each account.

**Transaction date.** In the Transaction date field, select a date range for transactions to include in the report.
If you select <Specific range>, you can specify a start date and an end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Post date.** In the Post date field, select a date range for the post dates of transactions to include in the report. If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all activity from the start date until present is included. If both fields are blank, all activity is included.

**Include adjustment transactions.** Mark this checkbox to include original transactions and their adjusting transactions in the report.

**Include miscellaneous entries.** Mark this checkbox to include miscellaneous entries in the report. A miscellaneous entry is a one-time adjustment you use in lieu of negative cash amounts.

**Note:** Click Preview to view the report as it will print using your selections and filters. Click Layout to view a sample layout of the report without data.

**Create an output query of [ ].** Mark Create an output query of, to create a query of accounts or payments that appear in the report. You can use the query later in other areas of Cash Receipts.

**Report orientation.** If you select to create the report in summary format, you can select Portrait for the report to appear vertically or Landscape for the report to appear horizontally. If you select to create the report in detail format, the Report Orientation field is disabled and the orientation is set to Landscape.

## General Ledger Report

The General Ledger Report in detail is a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the Reports Guide for General Ledger.

## Troubleshooting Cash Receipts Reconciliation

If numbers produced from reports in General Ledger and Cash Receipts do not match, determine which is higher. Consider these scenarios:

**Higher Cash Receipts balance.** Check for transactions entered with a post status of Do Not Post; General Ledger does not reflect this activity unless transactions were entered manually in General Ledger. Also, any activity with transaction and post dates in different periods may not appear in General Ledger for the same time period.

**Higher General Ledger balance.** Check for manual journal entries made to the account in question. Cash Receipts does not reflect manual journal entries, and these entries change the account balance. Also, activity with transaction and post dates in different periods may affect this scenario.
Reconciling The Patron Edge to General Ledger

Closed Drawer Report ................................................................. 56
General Ledger Report .............................................................. 57
Troubleshooting Patron Edge Reconciliation .................................. 61
To ensure activity in The Patron Edge is correctly reflected in the general ledger, reconcile gifts posted from The Patron Edge to General Ledger on a monthly basis.

As part of the reconciliation process, we recommend that you run the Closed Drawer Report and the General Ledger Pre-Post Report in The Patron Edge before creating the export file of transactions. For more information about exporting transactions from The Patron Edge, see The Patron Edge and The Financial Edge Integration Guide.

After importing and posting the transactions in The Financial Edge, you should run the General Ledger Report in detail from the Reports page of General Ledger. You can run this report specifically for transactions with a “Patron Edge” journal code. You should then compare the reports with those you generated in The Patron Edge and make sure the transactions match.

Before running these reports, you should familiarize yourself with the following information:

- “Considerations Before Reconciling” on page 2
- “Steps to Prevent Errors” on page 3
- “Reconciliation Process” on page 4

Closed Drawer Report

From Administration, you can run a Closed Drawer Report that provides a rundown of the transactions associated with each drawer closing that occurred during a specified period of time.

- Running the Closed Drawer Report
  1. From The Patron Edge, access the navigation bar and click Administration. The Administration screen appears.
  2. In the treeview, double-click Reports and then Daily.
4. In the **From Date** and **To Date** fields, specify the dates during which the drawer closings to include occurred. Any transactions associated with the drawer closings during the specified period of time will be included.

5. Mark **Break Down by Drawer** to show transactions grouped by the drawer in which they were received and processed.

6. Mark **Sort by Close Register Number** to show transactions sorted by the register number in which they were processed.

7. In the **Site** field, select the site for which you are running the report. For example, a common site is “Box Office.”

8. In the **Drawer** field, select the drawer for which you are running the report. The default selection is “All.”

9. To include sales details, show details, and/or totals, mark the corresponding checkboxes. To include only totals, mark the **Totals Only** checkbox. If you include only totals, the other checkboxes are inactive.

10. To include detailed report information about the drawer transactions at each of venue, mark **Detailed by Venue**.

11. To summarize the transactions by account, mark **Summarize By Account Numbers**. If you mark this option, the sales details, show details, show totals, and totals only checkboxes are inactive.

12. When you are ready to run the report, click **Print**. The report prints to your default printer.

### General Ledger Report

From *The Financial Edge*, you can run the General Ledger Report in detail, which provides a list of transaction activity for accounts during a specified range of accounting periods. Details include beginning and ending balances and debits and credits posted to the account.

For more information about the General Ledger Report, see the Account Reports chapter of the *Reports Guide for General Ledger*. 
Running the General Ledger Report in detail

1. From the Reports page in *General Ledger*, click **Account Reports**. The Account Reports page appears. A list of all account reports appears on the left of the page.

2. In the list on the left, select **General Ledger Report**.

4. In the **Template** field of the **Include accounts from this chart template** frame, select to include all or selected accounts in the report. You can create chart templates in **Visual Chart Organizer**. For more information, see the *Visual Chart Organizer Guide*.

5. In the **Date** field of the **Include account activity as of this date** frame, select “<Specific range>”.

6. In the **Start date** and **End date** fields, enter the same starting and ending dates used for the reports in *The Patron Edge*.

7. In the **Report orientation** field, select “Landscape”.

8. Select the Filters tab.

---

**Note:** You can change the results of a report by using different chart templates to run the same report. You can define an unlimited number of templates in *Visual Chart Organizer*. For more information, see the *Visual Chart Organizer Guide*. 
9. In the **Include** column for the Accounts filter, choose “Selected”. The Accounts screen appears.

![Selected Accounts](image)

**Note:** You can use the small binoculars to search for an account segment or use the large binoculars to search for an account number.

10. In the **Account** column, enter the account numbers for *The Patron Edge* or click the binoculars to search for the accounts.
11. Click **OK**. You return to the Filters tab and the selected account numbers appear in the **Selected Filters** column.
12. In the **Include** column for the Journals filter, choose “Selected”. The Selected Journals screen appears.

![Selected Journals](image)

13. Select your journal code for *The Patron Edge* and click the single right arrow. The journal appears in the **Include these journals** box.
14. Click **OK**. You return to the Filters tab and the *Patron Edge* journal appears in the **Selected Filters** column.
15. Click **Print**. A message appears telling you the program is processing the report.
16. Click the **Save** button on the toolbar to save the new report. The Save Report as screen appears.

![Save Report as dialog box](image)

17. In the **Report name** field, enter a name for the report.

18. In the **Description** field, enter a description.

19. To give other users rights to run or modify this general ledger report, mark **Others can run this report** and **Others can modify this report**.

20. Click **Save** to save the new report.


### Troubleshooting Patron Edge Reconciliation

Numbers produced from reports in *The Patron Edge* and *General Ledger* may not match because of activity not yet posted or imported. If *The Patron Edge* contains transactions not yet posted or if posted batches are not imported (or are mistakenly imported more than once), balances in *General Ledger* will be affected.
Index

A
account activity report 14
account balance report 14
account distribution report
Accounts Payable 18
Cash Receipts 53
Fixed Assets 30
Payroll 24
Student Billing 12
The Raiser’s Edge 38
Accounts Payable
reconciliation issues 10
reports for reconciling to General Ledger
general ledger report 10
open invoice report 9
Accounts Receivable
reconciliation issues 20
reports for reconciling to General Ledger
account distribution report 18
general ledger report 20
open item summary report 19
aging report 13

C
Cash Receipts
reconciliation issues 54
reports for reconciling to General Ledger
account distribution report 53
general ledger report 54
cash receipts report
Student Billing 15
closed drawer report 56
The Patron Edge 56

E
encumbrance report 34

F
Financial Edge, The
general ledger reports 57
Fixed Assets
reconciliation issues 32
reports for reconciling to General Ledger
account distribution report 30
general ledger report 32
year to date depreciation report 31

G
General Ledger
reports 57
running
detail reports 58
general ledger audit report 41
general ledger report
reconciling to
Accounts Payable 10
Accounts Receivable 20
Cash Receipts 15
Fixed Assets 32
Payroll 27
Purchase Orders 35
Student Billing 15
The Raiser’s Edge 44
The Financial Edge 57
general ledger reports 57
General Ledger, reconciling considerations 2

O
open invoice report 9
open item report
Student Billing 13
open item summary report
Accounts Receivable 19

P
Patron Edge, The
closed drawer reports 56
Payroll
reconciliation issues 27
reports for reconciling to General Ledger
account distribution report 24
general ledger report 27
payroll journal 25
payroll journal 25
Purchase Orders
reconciliation issues 35
reports for reconciling to **General Ledger**
  encumbrance report 34
general ledger report 35

R

**Raiser's Edge, The**
reports for reconciling to **General Ledger**
  account distribution report 38
  general ledger audit report 41
  general ledger report 44, 48
reconciliation issues
  **Accounts Receivable** 20
  overview 2
  **Student Billing** 15
  **The Raiser's Edge** 50
reconciliation process 4
report
  closed drawer reports 56
  general ledger reports 57
running
  closed drawer reports 56
  general ledger reports 58
running
  closed drawer reports 56
  general ledger reports 58

S

**Student Billing**
reports for reconciling to **General Ledger**
  account balance report 14
  account distribution report 12
  aging report 13
  cash receipts report 15
  general ledger report 15
  open item report 13
  student account activity report 14
  transaction journal 15

T

**The Patron Edge**
reconciliation issues 61
transaction journal 15

Y

year to date depreciation report 31